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1 About this document 
This document contains information on the operation of the product. 

Note - if you have been using earlier versions of SiPass Entro documentation, you 
will now find information about some software configuring details in the Installation 
manual. 
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2 Safety 

2.1 Target Group 
 

Target readers Qualification Activity Condition of the 
product 

Operating 
company/customer 

No particular 
qualification 
required. 

Decide on whether 
and where/how the 
product/service will 
be used. 

Differs depending on 
the product. 
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3 Service description 
SiPass Entro is an access control system. It is designed for use in both small 
companies and large ones; wherever there is a need to control which people 
should have access to the different doors and departments in the premises. 

There is an advanced function for reservation (e.g. in sports arenas, conference 
rooms etc). It works in co-operation with the access control functions.  

Next to the doors, card readers with keypads (optional) are installed. They are 
connected to segment controllers, which are then configured from a PC. 

If needed, SiPass Entro can control up to 10 000 access control systems installed 
in different buildings. The systems may be connected directly to the PC or be 
connected via a modem and/or local area network. 

In
tel

lig
en

t S
ec

ur
ity

 &
 F

ire
 L

td



Description of equipment

9

Building Technologies 052_SiPass_Entro_6_5_A24205-A335-B318_e_en
Fire Safety & Security Products  10.03.2010

4 Description of equipment 

4.1 Software description 

4.1.1 Software applications 

The SiPass Entro software consists of three applications: 

Installer 
This application is used for setup of the hardware. Install PC, Controllers and door 
monitor contact and alarm zones.  

Entro 
This application is used for configuring and managing access groups and persons 
(cardholders). It can be treated as main part of the software, because it is used for 
daily operations. 

The following functions are integrated in the Entro: 

 Access control  
Add Cardholder, choose and configure Caretakers, create Access Groups, 
create Time Schedules, Zones (anti-pass-back zones, roll call zones, entrance 
limitation zones 

 Card printing (badge printing) 
Create your own card design and print it on an industry standard cards. 

 Video Surveillance (CCTV) integration 
The SiPass Entro system can be used in combination with a Siemens CCTV 
system. A connection can be done from the SiPass Entro software directly to 
install and maintain the CCTV system (e. g. DVRs and cameras) 

 Intrusion alarm system control  
A common application for the SiPass Entro is, beside access control, to control 
an external intrusion alarm system by means of an access card.  

 Reservation function 
The System Administrator sets which objects (such as card readers/doors) are 
to be included and chooses the relevant reservation time schedules. 
The users wanting to reserve times can use an ordinary web-browser (such as 
Internet Explorer). Alternatively use his/her card in a reservation terminal 
(InfoPoint IP811) – depending on how the system is configured. 

 Printouts 

Door Monitor 
This application is used to display event logs, door status and video sequences. It 
can be also used for unlocking doors via the PC. 
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4.1.2 Software windows 

Entro starting window 
When the Entro application is started the following windows is displayed (showing 
the list of persons): 

Entro start window 

Shortcuts 
There are two shortcuts sometimes available in the software, to help creating, 
editing or deleting information. They appear e g in the Access group properties and 
in the Person’s properties. 

Shortcut to Time schedule 

Shortcut to Access groups 

E. g. when you create a new person, click on the shortcut Access group if you have 
not yet created a suitable one. In the same manner you can click further to Time 
schedule if you want to create or edit a time schedule. In all cases you will come 
back to the previous step when you exit the menus. In
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4.2 System overview 
The system below is shown on three levels: 

 PC (with software) to send/receive information to/from the system via direct 
cable or network. The InfoPoint IP811 terminal is used for reservation 
functions. 

 SR35i controllers hold information and make decisions as to the access 
granted at the doors.  

 Door environments where door controllers, readers, keypads etc. are installed 
together with electrical locks.  

SR35i

SR35i

SR35i

SISTORE DVR

TCP/IP

SISTOREMX PowerErrorCameraRecordingHarddisk
SISTOREMX PowerErrorCameraRecordingHarddisk

1a1e

1e

1b 1c 1d

2

3

3

3

4

4

5

6

Different levels in the system. 
 

1a PC – Security Controller 

1b PC – System Administration 

1c PC – Visitor Management 

1d Local PC – System Administration  

1e Reservation Management 

2 Controllers  

3 Doors 

4 Video surveillance system connection (TCP/IP) 

5 Intrusion alarm control (relay output) 

6 Control inputs and outputs 
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4.3 System capacity and limits 

SiPass Entro software 
Software for control of up to 10 000 systems, each capable of managing up to: 

 512 wired doors and 512 wireless doors (RF) in up to sixteen controllers 

 40 000 cards 

 240 time schedules 

 480 access groups 

 240 zones (alarm, anti pass back, roll call, interlock and entrance limitation 
zones) 

 16 system users in 4 levels + installer level 

 14 holidays, 7 half days and 4 holiday periods in each time schedule 

Reservation functions 
 64 reservation objects (machine groups) 

 Maximum of 30 doors and/or IOR6 relays in each reservation object 

 32 time schedules with 24 intervals in each 

 Flexible interval reservation 

 Maximum number of reservations is 6100 

Video Surveillance (CCTV) integration 
 Maximum 16 DVR - one DVR per SR35i/SR34i 

 Maximum 128 cameras 

Card printing 
 Multiple card and/or receipt template design 

 Bulk printing of cards 
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5 Start the software 
The first time you start the SiPass Entro software you will be requested to create a 
system user [ 36] and thereafter logon again to be able to store events. 

1. In the Windows start menu, select Start > Program > SiPass Entro. 

2. Choose one of the three applications: Installer, Entro or Door Monitor. 

 The login window is displayed. 

3. Enter the user name in the user name field (default: bewa). 

4. Enter in password the password field (default: pass).  

5. If several systems exist, select one system. 

 If more than 20 systems exist there will be an additional search field.  

6. Enter a character. 

 The system finds any name that includes this. 

7. Click OK.  

 The SiPass Entro main window is displayed. 

Start applications via the icons 
It is possible so quickly start an Entro application, by using the icon. Proceed like 
this: 

1. Position the cursor over the icons and right-click. 

 A menu is displayed 

2. Select SiPass Entro or Door Monitor 

 Either of the applications is started. 

 Note that the Installer application must be started via Windows start. 
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5.1 Indicators for communication status 

Indicators in the application windows 
In the bottom right of the box there are two indicators: 

If the text ON LINE and a green indicator are displayed, the PC and the SiPass 
Entro application are connected to the access control system.  

If the text OFF LINE and a red indicator are displayed, SiPass Entro has no contact 
with readers and controllers. This means that the information registered in the PC 
does not reach the segment controllers.  

If the text DB UP TO DATE (DB = database) and a green indicator are displayed, 
the segment controller connected to the actual PC, have the same information as 
the PC.  

Note that in some circumstances (like upgrading, larger import of persons etc) 
there could be a delay in the transferring of information from the “first” controller to 
the next. Please study the display information in each SR35i for the correct status 
information. 

If the text DB OUT OF DATE and a red indicator are displayed, the segment 
controllers do not have the same information as the PC. Note that a certain amount 
of time may pass before the information has reached all segment controllers and 
that the system has to be ON LINE for this to be possible.  

You can also look at the status bar to see how far the transferring of data to the PC 
has gone. Normally it might be events that are transferred (in cases where the PC 
has been OFF-LINE) 

 

 
The default setting is that you will automatically be logged out of the system if no 
task is performed within 15 minutes. In the Entro application you may set the 
desired number of minutes [ 16] or disable. 
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Indicators in the Microsoft Windows toolbar 

In the bottom right of the window task bar the following symbol is displayed: 

Entro icon in the Windows notification area 

When displayed, an application called Entroser (SiPass Entro serial 
communication) is running in the background. This is a required condition for 
events to be displayed on the PC’s screen and/or stored on hard disk. Entroser will 
be running even if you exit any SiPass Entro application.  

Despite the name Entroser, this is also used in TCP/IP communication. 

Close application and stop communication 
In some cases a complete shut down of the SiPass Entro is required. E g during 
maintenance actions like updates, or similar. Proceed like this: 

1. Position the cursor over the icons and right-click. 

 A menu is displayed. 

2. Select Close Entro. 

 All communication (entroser) is stopped and the current database is stored. 
The icons disappear from the task bar. No events will be stored. 

 

 
For Windows 7, to see the notification icon, right-click in the notification area and 
select Customize notification icons. Find the entry for Entro and choose to Show 
icon and notifications in the drop-down list. 
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5.2 Personalize PC settings 

5.2.1 Auto log-off 

If the Auto log-off function is enabled, SiPass Entro, Installer and Door and event 
monitor will automatically be logged off if any of these programs have been idle 
(not used) for a certain time.  

This is how to set the desired settings: 

1. Open the Entro [ 13] application. 

2. Select on the menu System > System users. 

3. Select a system user. 

4. Click on the Edit button. 

5. Click the Advanced tab. 

6. In the top box, select whether or not automatic log-off should be applied and for 
how long the programs have to be idle before they are logged off (pull the 
indicator to the desired number of minutes). 

7. Click OK. 

5.2.2 Automatic deletion of events 

In SiPass Entro, information about events in the system, e.g. entries, are stored 
daily. To free disk space, event files can be deleted automatically after a certain 
time or when a certain file size is obtained.  

Proceed as follows: 

1. Open the Entro [ 13] application. 

2. Select on the menu System > System users. 

3. Select a system user. 

4. Click on the Edit button. 

5. Click the Advanced tab. 

6. Select when events should be deleted: 

 By time. Select the check box and set the desired number of days. Event 
files where the latest event is this old will automatically be deleted. 

 By size. Select the check box and set the desired file size in Megabytes. 
The entire event file is deleted when this file size is reached. 

7. Select if event files should be moved to the waste paper basket when they are 
deleted or if they should disappear at once. 

8. Click OK. 
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5.2.3 Automatic disable of unused cards 

When a card is unused for a selectable period of time, there is an automatic 
function for disabling cards (similar to when three incorrect PIN are entered). The 
System user only have to enable (or disable) the function and set the time 
parameter. 

It is possible to set the cards to be blacklisted up to 255 weeks after the latest use 
(one week resolution). 

There are some rules applied for this function: 

 The timer for the person is cleared if a new PIN is chosen and when the 
user/card performs a valid access. 

 The timers for all persons are cleared when the option to use this function is 
deselected. 

 If a cardholder is marked as a caretaker, the cardholders’ is not affected by this 
function.  

 If the network between SR35i’s is broken, no decision to disable cards is taken.  

 The disabling of a card generates an event in the system. 
 

 
Any card set as a priority card, that has been inactivated by this function, will be 
active locally in a door environment that are in the off-line condition (= no 
communication between the SR35i and the door). See section Add persons to the 
priority group [ 35] . 

Proceed as follows: 

1. Open the Entro [ 13] application. 

2. Choose on the menu System > System settings. 

3. Mark the tick-box for unused cards in the general tab to turn on the function. 

4. Select the appropriate period, in weeks, how often the card holder list shall be 
scanned for unused cards. 

Reset automatically blacklisted card 
A card disabled by this function is presented in the SiPass Entro application in the 
same way as cards disabled by three wrong PIN (e.g. **Name). 

When entering the edit mode of the cardholder, a dialogue box appears and 
explains the reason for the disabling. You then have the choice of enabling the 
card again or not. 

If the cardholder has more than one card – the name will be blacklisted and any 
extra card has to be edited explicit for making it active again (there will be ** in front 
of the unused extra card). 
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6 Order of configuration 
The SiPass Entro software consists of five main tabs: 

 Time schedules 

 Doors 

 Zones 

 Access groups 

 Persons 

We recommend that you follow the above order when you configuring the system 
according to your specifications.  
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7 Set time schedule for access control 
The first thing to do is to identify the different types of working hours or other time 
divisions in the premises. Then decide what time schedules are to be used. Finally, 
decide what time zones are to be used within each time schedule. 

1. Open the Entro [ 13] application. 

2. Click the Time schedules tab.  

3. Click New.  
For new time schedules a wizard is invoked which will help you configure the 
required functions. For existing time schedules the tabs are shown (displaying 
the same information). 
The wizard also allows for directly configuring the Half days, Holidays and 
holiday periods. See Enter specific half days, public holidays and holiday 
periods [ 22] section. 

4. In the Name field, enter the name of the time schedule e.g. Office Hours, and 
press TAB.  

5. In the Name field of Time zone 1 square, enter the name of the first time zone, 
e.g. Work Hours, and press TAB. 

6. In the Name field of Time zone 2 square, enter the name of the second time 
zone, e.g. Lunch Time, and press TAB. 

7. The cursor is placed in the From field far left, next to the Mon. (Monday) text in 
the Time zone 1 square. 

8. Enter the first time interval for Mondays. Enter the time by typing four digits in 
succession, e.g. 0800 for 8.00. Continue with the next time interval, if any. 

9. Press TAB until the cursor is placed in the first From field in the Time zone 2 
square. 

10. Enter the time intervals defined for Time zone 2. 

The unspecified hours i e the remaining time, are always called Other time. This 
time zone is the third time zone. 
 

 
NOTE 1 

The time intervals must not overlap. If one interval in Time zone 1 ends with 
1200, the following time interval in Time zone 2 must start with 1201 

NOTE 2 

If you create separate time schedules for Doors and Access groups, you can 
easily change times for the security level of the door – or change times for only 
the authorities of different access groups 
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7.1 Copy time intervals 
You will probably want to use the same time intervals for Tuesday’s and the other 
weekday’s working hours. This is how to copy the time intervals defined for 
Monday. 

1. Place the pointer above the Mon. text and click the right mouse button. A menu 
is displayed. 

2. Choose Copy times using any mouse button. 

3. Place the pointer above the Tue text and click the right mouse button. The 
menu is displayed again. 

4. Choose Paste times. The time intervals are pasted – the ones you have 
defined for Time zone 2 as well. 

5. Follow steps 3–4 for the remaining weekdays using the same time intervals. 
Should the working hours be shorter on Friday, it is easy to change that 
interval. 
The time intervals you have defined are illustrated graphically at the bottom of 
the window for you to check that you have configured the times correctly (see 
the example below).  

6. If you want to use the same half days, public holidays and holiday periods for 
all time schedules, click OK. The Time schedules tab is re-displayed. 
 If you want to define specific half days, public holidays, or holiday periods for 
this time schedule, go to the Enter specific half days, public holidays and 
holiday period [ 22] s section. 

7. Set up information for the next time schedule in the same way. Start by clicking 
New or click Duplicate. If the information is similar, you need only change a few 
pieces of information, e.g. the name of the time schedules. 

 
Other time Working hrs Lunch Working hrs Other time 

0 1 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

00.00 – 24.00 hours 
 

 
NOTE 

You can select a time schedule and right-click to invoke the same commands as 
the buttons. 
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8 Set time schedules for an intrusion alarm zone  
If the installer has installed an intrusion alarm system controlled by the SiPass 
Entro you can make use of special time schedules for automatically arming it. You 
can configure these schedules separately, or when you create the alarm zones. 
Note that the intervals can cover the midnight hour. 

1. Open the Entro [ 13] application. 

2. Click the Time schedules tab. 

3. Click New. 

4. For new time schedules a wizard is invoked which will help you configure the 
required functions. For existing time schedules the tabs are shown (displaying 
the same information). 

5. Enter the name of the time schedule under Name. 

6. To create the first interval, click on New. E. g. Monday evening. 

7. In the list box Start enter the weekday and time. E. g. Monday 18:00. 

8. In the list box Stop enter the weekday and time. E. g. Tuesday 07:00. 

9. Then choose how often the intrusion alarm will be armed. E. g. every 60 
minutes. 

10. Click OK. 

11. Repeat step 3 – 7 for every interval. E. g. Tuesday evening, Wednesday 
evening etc. 

Configure alarm activation exception 
It is possible to configure up to 14 different exceptions for each alarm time 
schedule. These setting are done on a separate tab in the alarm time schedule. 

1. Open the Entro [ 13] application. 

2. Click the Time schedules tab. 

3. Select the alarm time schedule and click Edit. 

4. Click on the tab Alarm activation exceptions. 

5. Create the intervals in the same way as the main alarm time schedules: 

 Start date and start time. 

 Stop date and stop time. 

 New arming interval. 
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9 Enter specific half days, public holidays and holiday 
periods 

The most common working hours in an office are Monday to Friday with Saturdays, 
Sundays and holidays off. Certain days, e.g. the day before a holiday, you might 
only work a half-day. Perhaps the company applies a fixed holiday period in July. 

To make the system understand that public holidays half days and holiday periods 
should not be treated as ordinary working days, this information must be 
configured. Holidays and holiday periods are automatically given the time zone 
Other time. 

Proceed as follows: 

1. Click the Time schedule tab and mark the time schedule and click Edit. 

2. Click the Half-day tab and New. A window is displayed.  

3. Enter the desired information. In the General half-days, public holidays and 
holiday periods section later in this manual you will find instructions on how to 
enter the information. 

4. If you want, you can mark the tick in the Use Global half-day table box. Then 
the days configured in the Global Settings menu in the Time schedule tab will 
be displayed - and used by this time schedule. 

5. Enter the desired information about other holidays and holiday periods in the 
same way. 
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10 General half-days, public holidays and holiday periods 
The next step is to configure half days, public holidays and holiday periods to be 
used generally in the premises. Remember that you can combine both general and 
unique settings (in each time schedule). 

10.1 Half days 
Proceed as follows: 

1. Open the Entro [ 13] application. 

2. Click on Global Settings in the Time schedule tab.  

3. On the Half days tab. 

4. Click New. The window Half days is displayed. 

5. Enter the date of the first half-day in the yymmdd format, e.g. 000430, or click 
the Calendar button (in the The calendar [ 43] section you will find 
instructions on how to use the calendar). 

6. Place the cursor in the leftmost From field under the Time zone 1 heading. 

7. Enter the working hours to apply for the first time interval during Time zone 1. 
Type four digits in succession, e.g. 0800 for 8.00. 

8. Enter the working hours to apply for the second time interval during Time 
zone 1.  

9. Enter time intervals for Time zone 2, if any, in the same way. 

10. Click OK. The Half days tab is redisplayed with the new half day registered. 
These days can be re-used by the time schedules. 

11. Proceed the same way to register the next half-day according to the chart. 
 

 
The time intervals must not overlap. If an interval in Time zone 1 ends with 1200, 
the following time interval in Time zone 2 must start with 1201 

10.2 Public holidays 
Below you will find instructions on how to configure public holidays for the year. 
Holidays belong to the Other time zone. 

1. Click the Public holidays tab.  

2. Click New.  

3. In the Date field, enter the date of the first holiday in the yymmdd format, e.g. 
000501, or click the Calendar button (in the The calendar [ 43] section you 
will find instructions on how to use the calendar). 

4. Click OK. The Public holidays tab is redisplayed with the date filled in.  
These days can be re-used by the time schedules. 

5. Click New and configure the next holiday accordingly. In
tel

lig
en

t S
ec

ur
ity

 &
 F

ire
 L

td



General half-days, public holidays and holiday periods 

24 

Building Technologies 052_SiPass_Entro_6_5_A24205-A335-B318_e_en
Fire Safety & Security Products  10.03.2010

10.3 Holiday periods 
1. In this section you will find instructions on how to enter holiday periods, if any. 

Holiday periods belong to the time zone Other time. 

2. Click the Holidays tab and click New.  

3. Enter the start date of the holiday period in the yymmdd format, e.g. 000630, or 
click the Calendar button (in the The calendar [ 43] section you will find 
instructions on how to use the calendar). 

4. Enter the end date of the holiday period in the yymmdd format, e.g. 000831, or 
use the calendar. 

5. Check that the information is correct, and then click OK. The Holidays tab is 
redisplayed with the holiday period filled in. These periods can be re-used by 
the time schedules. 

6. Click OK to close the Holidays tab. 
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11 Configure doors 
The next step is to configure information about doors. Depending on what the door 
centrals/readers are used for, different parameters can appear in the menus. 

11.1 Door relay time settings 
If you have a door monitor contact installed there will be three parameters to 
defined: 

 Unlock time = Maximum time for active relay (no buzzer). 

 Opening time = Maximum time for door open (no buzzer). 

 Door Held Warning Time = Maximum time (with buzzer) before Alert.  

The reason for having separate unlock and opening times is that it is now possible 
to have a shorter, fixed time when the relay is active and another, longer time to 
have the door open (with a “delayed” door held warning signal). 

Note that earlier versions of SiPass Entro had only a maximum opening time (= the 
lock relay to be active). 

The relations between these times (in worst case) can be seen in the diagram 
below. 

1.

2.

3.
4.

5.

 
Door monitoring time diagram (worst case when door is held open) 

 
1. Unlock Time (max). Lock Relay 

2. Door opened by user. Monitored by door contact. 

3. Opening Time (max). Monitored by door contact. 

4. Door Held Warning Time (max). Warning relay (only DC22) 

5. Alert relay (only DC22) 
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11.2 Setting properties 
1. Open Entro [ 13] application and click the Doors tab. 

Since the installer has already allocated addresses for the doors they are also 
registered with a name in the system. 

2. Select the name (by clicking it) of the door whose information you want to 
enter. 

3. Click Edit.  

4. The name of the door is displayed in the Name field. 

5. Enter the desired maximum unlocking time in the Unlock time field. Click the 
up- or down arrow respectively to increase or decrease the value, or enter the 
desired value in the field directly.  
The time available to open the door after a valid card has been swiped and/or a 
valid PIN has been entered. If the door is not opened during this time, it is 
locked again. Recommended opening time is 5 seconds. You can choose an 
unlock time between 1 and 99 seconds. 

6. Enter the desired maximum Opening time. This is the time the door can be 
open before the warning signal starts (a buzzer and/or warning relay). You can 
choose an opening time between 1 and 999 seconds. 

7. Enter the door held warning time in the Door held open warning time field. Click 
the up- or down arrow respectively to increase or decrease the value, or enter 
the desired value in the field directly. 
If the door is still open when the opening time is over, a buzzer sounds at the 
door for the time set as door held warning time. The buzzer reminds the person 
entering to close the door immediately as an alarm is about to go off. 
Recommended door held warning time is 20 seconds. You can choose a time 
between 1 and 99 seconds. 

8. In the Time schedule field, choose the time schedule applying to the door. Click 
the down arrow to display a list of available time schedules (the time schedules 
you registered earlier). You can also click on the clock icon to Create, Edit or 
Copy a time schedule. Then choose the desired time schedule by clicking the 
name. 

9. Choose security levels for the different time zones in the time schedule. Click 
the down arrow to display a list of available security levels. Then choose the 
desired security level by clicking the name. 

10. Choose the suitable security level to apply to the reader in off-line condition 
(e.g. during a communications breakdown) in the same way. Persons 
belonging to the Priority group are the only ones that can open doors in an off-
line condition. This is only true of doors where the PD30-EM, PD40-EM, DC22 
or DC12 door controllers with additional readers are installed.  

11. Click the Advanced tab.  

12. Enter the choices you have made for the door concerning access registration, 
remote opening (exit request) and background lighting. 

13. If you are using a motor lock, select which time zones the motor lock should be 
unlocked. In
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14. Select the Motor lock stays locked… check box if the motor lock should remain 
locked until the first person unlocks the door, e.g. in the morning. 

15. Enter whether the internal buzzer should sound on key presses or not. 

16. Select the Allow remote control of this door check box if the door will be 
operated from a PC, e.g. opened, via the Door and event monitor program. 

17. You can select how the exit request input will act (pulsed): 

 Marked means that the door is unlocked for the maximum opening time 
from the moment the input is activated. 

 Unmarked results in the opening time starting from the moment the input 
becomes inactive. I e the door can be externally controlled and the lock 
relay can be activated longer than the opening time. 
 
Select if this door allows for a temporary changing of security levels to 
Unlocked or Group code by a caretaker. See section Caretaker functions 
[ 62] on how this is managed at the door. 

18. If lift control is applied, you may go to the IOR6 Relays tab and activate the 
desired relays during certain time zones. By activating the relay for a specific 
floor during a specific time zone, the floor will be accessible without the use of 
cards or code. 

19. Click OK. 

20. Enter information about the next door in the same way. 
 

 
If you select a door and right-click you are able to Edit settings – or Show persons 
to see people authorized at this door. 
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12 Add access groups 
Before you decide on access groups, you should identify the departments or 
sections in the premises, what staff groups should have access to these 
departments and during which time zones they should have access.  

For example, the office staff may consist of people working in a number of different 
departments. If you do not want the reception staff to have access to the research 
department’s doors you can configure this. 

1. Click the Access groups tab.  

2. Click New.  

3. Enter the name of the access group in the Name field.  

4. If a common group code is to be used, enter the code in the Group code field. 

5. Choose the time schedule for the group by clicking the desired alternative in 
the list next to the Time schedule prompt.  
You can also click on the clock icon to Create, Edit or Copy a time schedule. 

6. Mark the tick box Caretaker if this group is allowed to temporarily change 
security levels for certain doors. This will also give access to all doors in a 
Reservation system (without reservation). 

7. Select the doors that the persons in this access group should have access to 
and during which time zones they should have access.  
For example, if you want the group to have access to the entrance 24 hours a 
day, select all check boxes for that door. 
If lift control is applied, the floor numbers will be displayed under the name of 
the reader controlling the lift. Select the floors to which the group should have 
access. 

8. Click the Alarm and entrance limitations tab (if this is displayed).  

9. Select the suitable alarm by-pass rights for this access group. 

10. If needed, select the desired entrance limitations for the group and the doors 
the group has access to. This can only be done if an entrance limitation zone 
has been created in SiPass Entro Installer. 

 Counter. Used if access should be limited to a certain number of entries. 
Later you may, for each individual people, specify the number of allowed 
entries (double-click the desired person on the Persons tab and click the 
Duration tab. Can be combined with limited access. 

 Limited access. Used if access should be limited to a certain number of 
entries per day (can be limited further to certain time intervals during the 
day). Limited access is specified in SiPass Entro Installer on the Zones 
tab, Entrance limitation). Can be combined with the counter. 

11. If the access group should also have access to a reservation object, click on 
the Reservation object tab and select the object(s). 

12. Click OK. 

13. Set up information about the next access group in the same way. Start by 
clicking New. 
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NOTE 1 

Group code cannot be entered if PIN without card is allowed (this can be set in 
the Installer application).  

NOTE 2 

Instead of clicking New, click Duplicate. If the information is similar for the next 
access group, you need only change a few pieces of information, e.g. name and 
group code. 

NOTE 3 

You can select an access group and right-click to invoke the same commands as 
the buttons. 
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13 Configure persons (cardholders) 

13.1 General settings 
Three settings affect the Person properties window where you enter information 
about persons.  

Set individual PIN 
There are two methods to set an individual PIN.  

 Set on a PC. 

 Set by each person at a door terminal. 
 
NOTICE 

 
If method should be changed, re-entering of PINs necessary.  

You can not change the method of entering the PIN during operation. In case you 
want to change the method you have to re-enter all PINs. Carefully consider the 
method. 

1. Open the Entro [ 13] application. 

2. Choose in the menu System > System settings.  

3. Select the General tab. 

4. There are two alternatives for setting the individual PIN [ 61] : 

 If the person’s PIN should be set on a PC, activate the option At PC. 
 If the person’s PIN should be set by each person at a door terminal, 

activate the option At Door.  

Set free fields 
 Enter a 10 character free text in the Title for Free Field in “Persons” screen field 

and the Title for Free Field 2 in “Persons” screen field. 
 This text will be displayed as a field title in the Person properties dialog box. 

For example, enter E-mail: if you want to be able to enter an e-mail address 
for each person you register. 

Set Priority persons 
1. Select the Priority persons tab. 

2. Select the cardholders which to be stored in the local door environment (door 
controller).  

 These cardholders can still access the door during off-line condition. This 
assumes the door has a controller/reader installed, that supports the Priority 
person functionality and the cardholder has access to the door. 

3. Click OK. In
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13.2 Add and configure persons 
The next step is to register the persons to have access to the premises and to 
divide them into access groups. Remember that there are commands in the 
software for importing information [ 65] from external files.  

Add person 
1. Open the Entro [ 13] application. 

2. Select the Persons tab. 

3. Click on the button New.  

 The Person Properties dialog appears. 

4. Enter the name of the person in the Name field.  

5. Enter the desired information [ 30] in the free fields. Maximum 40 characters.  

 If confirmation of a reservation is to be sent, the first Free field must be 
used for holding the persons e-mail address. 

6. For authorities in the Reservation module, choose a letter in the Member Group 
drop-down list. 

7. Enter a maximum 6-digit number. 

8. If member class is used, select the Member Group Settings tab. 

 Select the Member Group in the drop-town menu. 

9. Select the General tab. 

10. Enter the person’s 8-digit card number in the Card No.: field.  
- or - 
If you have a keyboard with a built-in card reader you can swipe the card 
through the reader instead. 

11. If the person’s PIN is set at the PC, enter the desired 4-digit code in the PIN 
field. Next time you edit this persons’ properties you will see stars **** in the 
field. 

 If personal code without card is allowed the Personal code without card 
check box is displayed. 

12. Tick the Personal code without card check box.  

13. Enter the desired code in the PIN Code field. Do not enter any card number. 

 If each person is allowed to choose his PIN at a door terminal, the PIN 
Code field is grayed-out. 
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Choose Access group 
1. Open the Person Properties dialog. 

2. Select the General tab. 

3. Choose which access groups [ 28] the person should belong to, by ticking the 
check box to the left of the desired access group. You can choose up to six 
access groups per person.  

4. To create, edit or copy an access group, click on the group icon. 

 The group’s name is displayed in the Selected Access square.  

5. To remove a group, double click the name in the Selected Access square.  
- or - 
Untick the check box in the Access Groups square. 

 The name disappears. 

Choose Personal doors 
1. Open the Person Properties dialog. 

2. Select the General tab. 

3. If access is to be given to some certain doors, click on the button Personal 
doors.  

4. Select the doors.  
The total numbers and access groups cannot exceed 6. The personal doors 
admits access 24-7 (= all time).  
Note that a door will only accept that 150 persons select it as a personal door. 

Set duration of a person 
1. Open the Person Properties dialog. 

2. Select the Duration tab.  

3. Enter from which date the person should be authorized in the system in the 
Start at field.  
- or – 
Choose a date by clicking on the button calendar [ 43] . 

4. Activate the option Until further notice.  
- or - 
Activate the option End at and enter the desired date.  

5. If the person’s access rights to certain doors should be limited, select Restrict.  

6. Use this alternative if the person belongs to an access group with entrance 
limitations. 

7. Click OK.  

 The Persons tab is re-displayed with the name of the person you registered. 

8. Register the next person in the same way.  
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Deactivate a person (cardholder) 
1. Open the Person Properties dialog. 

2. Select the General tab. 

3. To deactivate a person untick the check box Active. 
- or -  
Right-clicking a name in the card list. 
Make sure there is no checkmark in front of the menu Card active. 

 

 
You can select one (or more) persons and right-click – and you can choose 
among several commands. E g to make the card inactive, show authorized doors, 
export information etc 

13.3 Register unknown cards via the Door Monitor application 
Sometimes there will be "unknown card” displayed in the event log window of the 
Door and Event Monitor program. You can easily make a card valid for a new user 
by right-clicking on the card number. A new window will be shown where you enter 
information. 

13.4 Register cards with enrolment reader at PC 
If an unknown card is read to the PC (via the USB-RIF/2), a new window will be 
shown where you enter information [ 31] . 

13.5 Duplicate a card  
1. Open the Entro [ 13] application. 

2. Choose the Persons tab. 

3. Click on the Button Duplicate.  
- or- 
Choose Duplicate by right-clicking on a card in the card list. 

4. If the information is similar, change a few pieces of information, e.g. name and 
card number. 

13.6 Duplicate to several cards 
In a new system the card numbers are often in a series. You can easily configure 
these into SiPass Entro by using the extended duplicate function.  

1. Open the Entro [ 13] application. 

2. Select the Persons tab. 

3. Enter the first card [ 31] . 

4. Select the card to duplicate. 

5. Click on the arrows to the right of the Duplicate button. 

6. Enter the amount of duplicates the field Number of copies. In
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7. Enter the first card number in the First card number field. 
- or - 
Use the suggested (which is one higher than the selected card). 

In the Name field there are two choices: 

1. Activate the option for the actual name. 

2. Choose a number to add to it.  

 The card number is then incremented with one and the name will get a 
suffix (added with one for each). E. g. if a name Visitor is marked in the 
above – the next name will be Visitor – x (where x is the entered number). 

3. Activate the option Same as card number. 

 The card number is incremented and copied to the Name field.  

4. Click OK. 

 The same access group settings etc will apply to these duplicates. 

13.7 One person – multiple cards 
It is possible for a person to have multiple cards. E. g. when using one type of card 
in the office and another for parking.  

1. Open the person [ 31] details. 

2. Choose the Extra cards tab. 

3. Enter the names and card numbers to be valid.  

 Theses names will be shown in the event log.  
The PIN and access groups will be the same for all cards. 

4. To deactivate the card, untick the check box Active.  

Note that the extra cards are not supported by the import/export function. 
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13.8 Add persons to the priority group 
Using this function you can determine which people should be able to open a door 
in case of a communications breakdown in the system. Note that this only applies 
for doors controlled by the DC22/DC12 door controllers and PD30 & PD40.  

This is how to decide which people should have this authorization: 

1. Open the Entro [ 13] application. 

2. Select on the menu System > System settings. 

3. Go to the Priority Persons tab. 

4. Double-click on a person in the list Available and the name is copied to the 
Priority persons list. 

5. Click OK. 
 

 
To withdraw the authorization, double click the name in the Priority persons 
square. 

13.9 Show persons authorities for doors 
In the list of persons information about the authorized doors of a specific person 
can be get. 

1. Open the Entro [ 13] application.  

2. Select the Person tab. 

3. Select a person. 

4. By right-clicking choose Show doors.  

 A list of the doors is shown. 

5. Click Close.  
- or - 
Click Print. 
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14 Register system users 
In SiPass Entro you can register several system users, i.e. several people with 
authorization to configure the system. 

Several system users can be on-line concurrently if the system has been prepared 
for this. See section Multi-user environment (more PCs).  

The people appointed as system users can also be registered in the system as 
persons. In the Add and configure persons [ 31] section you will find instructions 
on how to do this. 
 

 
The first time you register a system user you can only choose the All rights level. 
The reason for this is that there has to be at least one system user with 
authorization to perform all tasks in the system. Also note that the user name 
bewa and the password pass will disappear as you register a system user for the 
first time. 

This is how to register system users: 

1. Open the Entro [ 13] application. 

2. Choose in the menu System > System Users. 

 The names of existing system users are displayed in this window. If you 
have not registered any system users yet, the window is empty. 

3. Click New. The System users window is displayed. 

4. Enter a suitable name in the User name field.  
Optionally you can tie a card to this User by clicking the down arrow in the next 
field to display a list of registered persons. This may be used in applications 
using a physical card for login. 

5. Select the desired name. 

6. Choose a password and enter it in the Password field (16 characters at the 
most). 

7. Enter the password once again in the Verify password field. 

8. Choose the desired user level for the system user you have registered.  

 If the person should have authorization to make all types of changes in the 
system, choose All rights. 

 If the person should have authorization to all functions except the ones 
reached from the System menu, choose All rights except system 
properties. 

 If the person should only have authorization to register, change and delete 
information about persons, choose Person properties only. 

 If the person should have authorization to remotely open doors with the 
PC in the Door monitor program choose Door control. 

 If the person acts as an Installer. 

9. Select the door& event filter to use, enter the connection and the folder to store 
events on for this System User. You can read more about filters in the section 
Event and door filters [ 41] . In

tel
lig

en
t S

ec
ur

ity
 &

 F
ire

 L
td



Register system users

37

Building Technologies 052_SiPass_Entro_6_5_A24205-A335-B318_e_en
Fire Safety & Security Products  10.03.2010

10. Select if the Alarm dialog window shall be visible. If so, a pop-up window will be 
displayed if an alarm event occurs. 

11. Click OK. The List of system users’ window is redisplayed with the name of the 
new system user.  

12. Click Close. If you exit SiPass Entro now you can log in with the user name and 
password you just registered. 

If you want more people to have authorization to configure SiPass Entro, proceed 
the same way to register the information. 
 

 
If the same computer is used for two or more system users, different directories 
for storing events must be defined. 

Otherwise the events may be overwritten. 
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15 Bank Lobby Function 

15.1 Using non-Entro cards for entrance 
In SiPass Entro cards of different types, e.g. credit cards or some organization’s 
special card can be used for access in dedicated readers. This is possible by 
configuring the card’s prefix and then select which readers to use this function. 

Remember that if the Bank Lobby Function are to be used at the same time as 
“ordinary” cards the security level always have to be Card only. 

Example 1 - Cards with exact prefix  
The card number is 5760 0096 0029 5679. The four first digits – the prefix – identify 
the card as a certain bank’s card and can then be entered as the prefix below. 

Example 2 - Cards with some wild card digits 
When configuring a prefix, a digit in the prefix can be substituted for a “wild card”. 
Any digit may occur in the wild card’s place to make the card valid. The wild card is 
represented by an asterisk “*”. If a prefix is configured as 1257*0, cards using the 
prefixes 125700, 125710, 125720, 125730, 125740, 125750, 125760, 125770, 
125780 and 125790 will be valid. 

In SiPass Entro, 15 prefixes can be configured. Each prefix may consist of 7 digits. 
The first digit in the prefix may begin at any position on the card. Information about 
prefixes on different cards can be obtained from the bank or company supplying 
the card. You may also contact Siemens Building Technologies for advice. 
 

 
Because the function requires that all positions can be read from the card (and 
then evaluated by the system) the card reader MUST be of the type Clock & Data 
and reading mag stripe card. E g the BC18. 

15.2 Configuring the prefix 
Proceed like this: 

1. Open the Entro [ 13] application. 

2. Choose in the menu System > System settings > Bank Lobby Function. 

3. Click New. 

4. Enter a Name e g VISA. 

5. Enter the Start position and the Prefix. 

6. Click OK and it will be stored in the list. 
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15.3 Decide on readers for Bank Lobby Function 
You have to setup each reader to operate with the Bank Lobby Function to allow 
for the use of these cards. 

Proceed like this: 

1. Open the Entro [ 13] application. 

2. Click the Doors tab and select a door. 

3. Select Bank lobby for the actual time zone. 

4. Click OK to apply the changes. 
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16 Access registration 
Every SR35i is striving to receive all events in the system storing them in its event 
buffer. I e events occurring in any part of the SiPass Entro system is mirrored 
between the segment controllers. 

Depending of how the configuring is done for each System users [ 36] , the 
registering, alarm reporting and graphical symbols will now be displayed according 
to the selected filter. It is important that the storage location (directory) have been 
defined for each System user. 

Remember that all controllers will attempt to get all events for making further 
decisions (filtering, alarm reports etc.) 

16.1 Decide on PCs to retrieve events 
When you create a System user, you must choose which PC to be his/hers 
‘primary’ PC, where events only are stored for this System User. Also you have to 
select which event filter and door filter to be used for this System User.  

This means that if the same person using his/her level of authorization logs onto 
another connection (PC) the events will NOT be stored on that computer. Read 
more about using more than one PC and multi-user database in the description of 
the system. 
 

 
The PC must be ONLINE with the SiPass Entro system to receive any events! 

In the section Door and event monitor [ 46] you will find instructions on how to 
start the monitoring program on your PC. 
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17 Event and door filters  
Event and door filters are used in different ways in the SiPass Entro environment: 

 To control common alarm outputs in the IOR6 (and alarm dialog pop-ups on 
the screen) 

 Reduce the amount of events stored on hard disk. 

 Control which events and door symbols to be displayed on the screen for a 
particular System user. 

 Searching in the event archive. 

Normally the system uses a standard event filter with recommended settings and 
displays all doors graphically on the connected PC. You do not need to change 
anything. 

The screen shot below shows a typical setting for the door monitor type of events. 

Event and door filter settings 

17.1 Decide on name for new event filter 
In every place in the software where you can/should select a filter you can create, 
edit and store your filter settings (to be able to re-use them). You can create a 
maximum of 32 event different filters. 

You can change filter settings – and then name it and save it. As follows: 

1. Click on the icon beside the list box. Then choose New filter. 

2. The Event filtering window is displayed. Enter the name for the new filter. 

3. For each Event group, choose which events are to be reported. 

4. Click the text, e.g. Valid access, to view the events belonging to this Event 
group. Then filter the events.  In
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 Ignore The event is not registered and cannot be retrieved later. 
 Normal The event is shown in the Door and event monitor and on 

printouts. 
 Alarm The event is defined as an alarm event i.e. is displayed in red in the 

Event window. 

5. To ignore all events in an event group, simply deselect the check box in front of 
the event group’s name. 

6. Click Door filter. Decide on which doors are to be displayed graphically on the 
screen and events to receive from. 

 

 
NOTE 1 

The events Exit request and Group code are by default set to Ignore and are not 
registered. 

NOTE 2 

Events marked Alarm are always printed, (only to the printers) even if you have 
requested nightly printouts only for this particular door. 

NOTE 3 

Events marked Alarm will also activate any Common alarm relay in any of the 
IOR6 (if activated). In addition, alarm-marked events are displayed as pop-ups on 
the PC’s screen. The pop-ups are displayed even though the Door monitor 
program is not running, on condition that Entroser is running (see section 
Indicators for communication status [ 14] ). 

17.2 Managing Event filters 
You can also edit, copy or delete event filter settings. Mark the filter and click the 
button - but choose Edit filter, Copy filter or Delete filter. 

You will get a warning message if you try to delete a filter that is in use. 

17.3 Use event filters 
You can reload already stored event filters, to simplify setting up, if you for instance 
have several common alarm or System Users (which should perform event 
control). 
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18 The calendar 
By using the calendar you can enter a date quickly and easily, with only one mouse 
click e.g. when you are configuring holidays or holiday periods. The calendar can 
be reached from all windows where you are requested to enter a date. 

Proceed as follows: 

1. Click the Calendar button.  

 This is what the calendar might look like if you clicked on the button in the 
Holidays window: 

 

2. Choose the desired start date (applies to holiday periods) by clicking it. The 
date is displayed in the Starting date field.  

3. Choose the desired end date by clicking it. The date is displayed in the Ending 
date field.  

4. Click OK. The dates are displayed in the window from which you activated the 
calendar. 

By clicking the double arrows you can browse one year backwards and forwards 
respectively. Click the single arrows to browse the calendar one month backwards 
and forwards respectively. 
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19 Encryption functions in Local Area Network 
SiPass Entro uses integral encryption software when communicating in network 
environments. This higher security level is necessary - especially when SiPass 
Entro is installed in Internet applications. 

The user of SiPass Entro should regularly change the crypto key needed by the 
encryption algorithm. The crypto key will always be stored in the database. The 
algorithm uses 128-bit level. 
 

 
If the crypto key is not correct the communication is not established – and the 
system must be completely reset and re-configured. 

19.1 Encryption gives higher security 
Because of the fact that network use needs an encryption algorithm the security 
aspects of a system are improved. At the same time this raises some important 
points: 

 Always write down the crypto key as soon as it is changed from the standard! 

 There are no back-doors into the system. I e there is no work-around if the 
crypto key is lost.  

 The only way to re-create a system - is to reset it and re-configure the entire 
information.  

 

 
A good idea is to use the default crypto key (used at delivery) until the system is 
completely set-up – and then change it. 
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19.2 Change the crypto key 
1. Open the Entro [ 13] application. 

2. Click on System and select Change crypto key.  

 A wizard is invoked to guide you further. 

3. Select in which way the crypto key should be created: 

 The System creates the crypto key automatically. 
 You enter the crypto key manually – at least 32 characters. Valid 

characters are 0-9, A-F (hexadecimal, upper case). 
 Use a default (which also is used in the SR35i at power-up – if no 

database is loaded). 

4. Click Next. 

5. If you have chosen to enter the crypto key manually – a field appears where 
you enter the 32 characters. 

 The entered/generated crypto key is shown. Do not forget to write it down 
and keep it in safe place! 

6. Click Next – and the new crypto key is sent to all SR35i. All SR35i must be on-
line to make the encryption work. 

7. Click OK. 
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20 Door and event monitor 
The section Access registration [ 40] described how to choose which doors will 
be monitored on your PC. Below you will find instructions on how to use the Door 
and event monitor program. 

1. Open the Door monitor [ 13] application. Note that you can also start the 
application from SiPass Entro File menu. 

2. Choose Event log on the File menu (if the Events window is not already 
displayed). 

Each event defined as Normal or Alarm is displayed (see the section Access 
registration [ 40] ). Alarm events are displayed in red. The events will appear on 
the screen as they occur. 
 

 
The PC must be ONLINE with the SiPass Entro system to receive any events! 

20.1 Multiple windows with different monitoring focus 
By opening multiple event windows you can monitor different doors, persons, 
events etc in different windows. 

Proceed as follows: 

1. Choose New Event log on the Event log menu. A new event window named 
Events:2 is displayed. The first event window is renamed Events:1. 

2. Choose Tile windows on the Window menu. The windows are arranged side by 
side. Both windows display the same events. 

3. Click the right mouse button on the Events:2 window. A menu is displayed. 

4. Choose Change filter. The Change filter window is displayed. 
Now you can choose whatever you want to monitor in this window. For 
example, you can monitor a specific person and/or a specific door. You can 
also customize the event filter, e.g. to limit monitoring to certain types of 
events. 

5. To customize the event filter, click Custom filter. 

6. Click Set filter. The Event filter window is displayed. 

7. Select which event types to monitor in the Events:2 window, and then click OK. 
The Change filter window is redisplayed. 

8. Click OK. Now you have two event windows monitoring different movements.  

9. To add more event windows, choose New Event log on the Event log menu 
and then Tile windows on the Window menu.  
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This is what the screen might look like when you are using four event windows: 

 
 

 
To simplify monitoring, the event windows can be named. 

Right-click the desired window and choose Name view. The Set name of view 
window is displayed. Name the view and click OK. Filtered and named views will 
reappear even if the program is shut off and restarted. 

 

20.2 Search events 
To search for old events in the archive, proceed as follows: 

1. Choose Search events in archive on the Search menu. The Event search 
window is displayed. 

2. As in when you are choosing what to display in a monitoring window, you may 
search for events relating to specific persons and doors. Using the custom filter 
you can choose what event types to search for. 

3. Choose the desired settings. 

4. To limit the search to specific dates and times, select the Events after and 
Events before check boxes and state the desired date and time intervals. 

5. Click Search. Events corresponding to your search concept are displayed. 

6. You now have the option to export this information by using the command Save 
events in the System menu and select file format. 

This can be used for searching for example reservation events and for further 
administration in external software such as Excel or similar. 

20.3 Using several camera and door status windows 
It is possible to display both camera and door icons in several windows. E g if you 
want to collect some part of a facility in the same view. To customize the view 
proceed like this: In
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1. Position the cursor in any Object window. 

2. Right-click, select Change filter and choose which doors and/or cameras to 
view. 

3. Optionally name the new window by right-clicking again. 

It is possible to create several windows with mixed or different doors/cameras. 
 

 
The viewing of images is supported for displaying on the primary screen of the 
Windows environment. Depending of the type of graphic card etc it might be 
possible to use a secondary screen – but not guaranteed 

20.4 Camera operation in PC 
The viewing of images is supported for displaying on the primary screen of the 
Windows environment. Depending of the type of graphic card etc it might be 
possible to use a secondary screen – but not guaranteed 

If you are familiar with a particular DVR environment you will recognize some 
commands. If not – you will find the information in the DVR User manual. 

20.4.1 Camera icons 

You will see some camera icons in the Object window. 
 

 
Normal state – camera on-line and stand-by. 

 

 
Camera is recording 

 
Status unknown (possibly caused by error in the 
communication with the camera).  

Live view to PC may work.  

 
Camera error. Typically by black-out (covering camera) 
or white-out (directing a lamp) on camera. 

20.4.2 Live view without recording 

Some times it is desirable to monitor a door or similar without recording. This 
means streaming images continuously to a window in the PC.  

Remember that a Viewer software must have to been installed in the PC prior to 
using this command. 

Double-clicking on a camera icon will invoke a new window and display live 
images. 
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20.4.3 Manually recording 

In the Installer program you may have configured that an automatic recording shall 
be performed.  

You can also perform a manual start and stop of a recording. Note that you of 
course must keep track of the duration manually. Also remember that this 
command uses the settings (like frame rate) in the DVR. Be careful – this 
command can generate large files in the DVR. 

Proceed like this: 

1. Select a camera icon in a Door monitor. 

2. Right-click and select Start recording. The camera will now store images on the 
DVR. 

3. Abort the recording by right-clicking again and select Stop recording. 

This will generate an event which then can be viewed with an event log command. 

20.4.4 View recordings in the event log 

Normally you use the event log in the Door monitor to find and replay recordings 
triggered by the SiPass Entro application. 

If e g a door has been forced, this event may generate an alarm event that both 
sends a hardware signal (IOR6) and triggers a recording.  

In the event log an image sequence is indicated by an icon in front of the event.  
 

 
Recording started or finished. Clicking on the icon will normally replay the 
sequence.  

But when clicking on it during recording will instead start a start Live view. 

 
No recording from camera. 

Proceed like this: 

1. Select by scrolling (or searching) the event log for an event with a camera 
symbol. 

2. Double-clicking on the event and the recording will be displayed in a new 
window (in the DVR Viewer). 

 Depending of the DVR in use, different command options may further be 
used by right-clicking in the viewer window. 

3. Perform any required actions. 

4. Exit the viewer window.  

Remember that if the event window in SiPass Entro indicates that an image 
sequence has been recorded but then separately deleted in the DVR, an “empty” 
window will be seen. 

In
tel

lig
en

t S
ec

ur
ity

 &
 F

ire
 L

td



Door and event monitor 

50 

Building Technologies 052_SiPass_Entro_6_5_A24205-A335-B318_e_en
Fire Safety & Security Products  10.03.2010

20.4.5 Search and view recordings from one camera 

Right-clicking on a camera icon and selecting Event log will display events from 
just that specified camera. Perform the steps above to view any recording. 

20.5 Door operation from PC 
The Door and event monitor also includes graphical door status display. This is 
where you can operate the door directly from the PC, e.g. open the door. To make 
this possible you have to enable this function for each door to be operated from the 
PC. The option is found on the Doors/Advanced tab in the SiPass Entro 
application. You can also activate or deactivate a bistable intrusion alarm (if 
authorized with all rights). 

The following symbols exist: 
 

 

The door is locked. This is the normal state even for granted accesses. 

 

The door is unlocked. 

 

Alarm event on locked door. Example: The card reader has been vandalized. 

 

Alarm event on unlocked door. Example: The door held warning time has expired. 

 

Unknown status. Displayed when the system is off-line, e.g. when you are working with a 
modem connected system (see the Working with multiple systems [ 57] section). 

 

Alarm activated. Shows that SiPass Entro understands that an intrusion alarm is turned on 
and that the door is blocked. 

 

Alarm event on a door where the alarm is turned on. E g if the door is forced. 

Right-click a door symbol to display a menu where several options for door 
operation are available, e.g. Remote open, Toggle open etc. You can also display 
the door’s event log and open a window displaying the door’s current status. 
 

 
To be able to operate a door from the PC you have to be logged on and be a 
level 1 or 2 system user, i.e. with all rights or all rights except system settings. 
There is however a special level of system user that permits remote control of 
doors. 

You can log on by starting the SiPass Entro application and log on, or choose 
Login on the File menu in the Door monitor. 
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20.5.1 Open/close all doors 

In case of fire or in other circumstances when all doors need to be opened at once, 
choose All Doors Open on the Door menu. To close the doors, choose All Doors 
Reset. 
 

 
To be able to open/close all doors from a PC, you have to be logged on and be a 
Level-1 System user, i.e. with all rights.  

You can log on by starting the SiPass Entro application and log on, or choose 
Login on the File menu in the Door monitor. 

20.6 Roll call 
If you have created roll call or anti-pass back zones, the Roll call view shows the 
whereabouts of different persons in the premises. 

1. Choose Roll call on the File menu. The Roll call view is displayed with names 
of persons and the zones they are currently visiting. 

2. The view can be filtered further if needed. Right-click and choose Change filter. 

3. To monitor several zones or persons at the same time, right-click and choose 
New roll call view. A new window is displayed. Arrange the windows on the 
screen by choosing Tile windows on the Window menu. Then filter each view 
as desired. 

20.7 Reset blacklisted card 
Persons who have violated anti-pass back, i.e. not used their card to leave a zone 
they have previously entered, and persons that have entered three incorrect PIN in 
succession, get their cards blacklisted. This is displayed in the Roll call view and in 
SiPass Entro Person’s tab with two asterisks (**) in front of the name. To reset the 
card, double-click the name. Note that you have to be logged on in SiPass Entro or 
the Door monitor to be able to do this. 
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21 Card printing 
The card (badge) printing facility can be used for adding images (photos) on the 
cards but also for printing receipts to be signed by the card holder (when handing 
out cards). 

However, cards can be printed without images and the function may also be used 
for printing receipt only. 

Some steps should be considered before any cards can be printed. 

 Designing of card template(s) and storing them in a library. 

 Designing of receipt templates (optionally). 

 Linking the photos to card holders in the database. 

Printing one or more cards can then be performed. 

21.1 Pre-requisites 
These are the requirements to be able to use card printing: 

 A third party card printer installed. It is important that this printer is Windows 
compliant. Please read the manufacturers documentation how to install.  
Note that for receipt printing a standard Windows printer may be used. 

 Suitable access cards aimed for printing. 

 One PC chosen to store the main set of cardholder photos. 

 Digital Photo equipment to create and prepare suitable photos. 

The photos are stored in a separate database in the PC used. 

21.2 Template design tool 
In the SiPass Entro software there are a special tool that is used for creating and 
maintaining both card templates and/or receipt templates. 

The templates are used when printing the actual cards and means that the same 
information can easily be printed in different layouts. 

21.2.1 Static or dynamic information 

It is also possible to use both static and dynamic information in the template: 

 Static means that this will appear on all cards using the same template, e g a 
company logotype. 

 Dynamic means that it will be linked to the cardholder data, e g card number. 
This information is fetched from the fields in person’s tab. 
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21.2.2 Card layout templates and/or Receipt layout templates 

Because you create both card templates and receipt templates in a similar way – 
both commands are in the same dialog window. You may create several types of 
templates as well as deleting.  

Note that for the receipt the preview and format will be different. 

Proceed as follows: 

1. Open the Entro [ 13] application  

2. Choose System > Badge and Receipt templates. 

 A list of existing templates and receipts are displayed. 

3. Select an old to edit - or create a new template. 

 A window is displayed with icons and buttons as well as a preview.  

4. Enter the name, e g Normal and enter a brief description. 

5. Select the orientation Portrait or Landscape. 

6. Select if double-sided or not. 
If double-sided is selected, a new back side tab appears. Note that the 
orientation must be the same for front & back side. 

7. Click on any of the three icons Text, Photo or Rectangle. 

8. Drag-and-drop the objects to a suitable positions. A preview is displayed. 

 As soon as an object is positioned and then selected again, the window 
changes slightly and displays its properties. 

9. Optionally change values for any of the object’s property settings (size, fonts, 
color etc). 

10. Close when finished. 

21.2.3 Static and/or dynamic text 

Both static and dynamic text may be positioned in the template.  

Proceed like this: 

1. Open the Entro [ 13] application  

2. Choose System > Badge and Receipt templates. 

3. Drag-and-drop new text objects into the template (or mark an existing). 

4. Select one of the following two options: 

 Enter a static text in the field Text and this object does not change. 
 Click on the arrow in the drop-down list Text for linking a dynamic text. 

Select any of the pre-defined variables. 
 Currently there are following selections (linked to the person’s properties): 

Cardnum 
Name 
Validto 
Validfrom  
Free_field_1 In
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Free_field_2 
Member_group 

5. Optionally change any general properties for the text. 

6. Repeat for each text object. 

21.2.4 Static and/or dynamic images 

As soon as an image frame is positioned there is a choice of image type: 

 Static images, e g logotypes, can be imported by browsing an image library. To 
add it, mark the positioned image frame and import the image. 

 Dynamic photo from person tab. This choice will link dynamically to the current 
photo of the card holder. So when the template is used for a print, the system 
will automatically change the photo. 

There might be some automatic re-sizing of the images, so it is advisable to 
prepare the images and make some tests to fulfill the particular needs. 

21.3 Linking images to card holder 
When the templates are created and the data is entered for any card holder you 
need also to import the image (photo) and link it in the person’s tab.  

Proceed as follows: 

1. Open the Entro [ 13] application  

2. Go to Persons tab. 

3. Select a person in the list. 

4. Click Edit. 

5. Click on Image and Badge tab. 

 A dialog window is displayed with new commands. 

6. Click on From camera or From file input to import the image. Follow the 
instructions. 

 The image is now linked (dynamically) to the card holder. 

7. Click OK – or click on Print card. 
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21.4 Printing a card 
When one (or more) card holder data is prepared it is time to print the card(s). 

Proceed as follows: 

1. Open the Entro [ 13] application  

2. Go to Persons tab. 

3. Select a person. 

4. Click on Image and Badge tab. 

5. Click Print card. 

6. Select a layout template. 

 A preview of the card is displayed. 

7. Select the printer 

 Optionally also print the receipts for the person (if any template exist). 

8. Finished. 

It is also possible to only print the receipt by using the Print receipt button. 

21.4.1 Print with right-click command 

It is possible to print a single card or several cards in a batch.  

Proceed as follows: 

1. Open the Entro [ 13] application  

2. Go to Persons tab. 

3. Select one or more persons by holding down the <ctrl> or <shift> and mark the 
cards to print. 

4. Right-click, select Print card(s) and follow the instructions on the screen. E g 
selecting the templates for the cards. 

 Optionally also print the receipts for the persons. 

5. Finished. 

21.4.2 Print in a Terminal server environment 

If the card printing function is used in a Terminal Server environment please 
consult the IT department how to setup. 
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22 Printouts 
SiPass Entro provides you with two types of printouts: 

 Configured information. At any time you can print the information you have 
configured about time schedules, doors, access groups and persons. Print the 
information by choosing Print on the File menu. This type of information can 
only be printed to printers directly connected to your PC. 

 Events. This type of information can be printed to a printer connected to the PC 
or automatically to a printer directly connected to a segment controller. 

22.1 Configured information 
Proceed as follows: 

1. Choose Print on the File menu.  

2. Choose what information to print. In the above example the Persons option is 
pre-set. SiPass Entro automatically suggests the option corresponding to the 
tab being active when you chose Print. 

The Selected persons, Selected doors etc. options mean that only information 
about the person, door etc. selected on the tab is printed (make your selections 
before you choose Print). By clicking Preview you can view the printout on your 
PC’s screen. 

22.2 Events 
Events can be printed from the Door and event monitor.  

Proceed as follows: 

1. Open an event log by choosing Event logs on the File menu (if it is not already 
displayed). 

2. Right-click somewhere in the event window.  

 A menu is displayed. 

3. Choose Change filter. 

4. Select the types of events to be displayed. 

5. Click OK. 

6. Choose Print on the File menu 
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23 Working with multiple systems 
This section describes how to provide a modem-connected system with information 
about time schedules, persons, access groups, doors etc. 

23.1 Logging in 
As you log in you can choose which system to work with. 

1. Open the Entro [ 13] application.  

 The log on window is displayed. 

2. Enter user name, password and connection. 

3. In the System list box, choose the system you want to configure. If more than 
20 exist there will be an additional search field. You enter a character and the 
system finds any name that includes this. 

4. Click OK.  

 The system’s site name is displayed in the title bar of the window. Otherwise 
the window is empty. The red indicator next to the OFF-LINE text tells you that 
you have no contact with the modem-connected system. 

23.2 Dialing the modem connected system 
This is how to establish modem connection with the system you logged in to: 

1. Click the lifted handset symbol or choose Dial on the Modem menu. A 
message is displayed while the system tries to establish a connection. 

2. When the connection is established, the ON LINE indicator is lit green to 
indicate that you have direct contact with the dialed-up system the following 
message is displayed. 

3. Wait until the DB UP TO DATE indicator turns green. This may take a couple of 
minutes since information has to be transferred.  

4. When the DB UP TO DATE indicator is lit green, your PC contains the same 
information as the dialed-up system.  

23.2.1 Configuring information 

1. Configure the information in the modem-based system. 
 

 
SiPass Entro should always be ONLINE (dialed-up) when you configure a 
modem-connected system. This makes information transfer quicker and safer. 

2. Wait until the green indicator and the DB UP TO DATE text is displayed bottom 
right in the SiPass Entro window.  

3. Click the replaced handset symbol or choose Hang up on the Modem menu. In
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23.2.2 Starting Door monitor without interrupting the modem connection 

The following symbol is displayed bottom right on the PC’s screen: 

Communication icon 

Click the right mouse button on the two indicators to display a menu where Door 
monitor is one of the alternatives. In the same way, you can switch from Door 
monitor back to SiPass Entro. The modem connection will not be interrupted. 

23.2.3 Logging in to another system 

On the File menu you will find an alternative named Login to another system. 
Choosing this alternative you do not have to exit Entro to configure another system. 
Instead, the login window is displayed for you to log in to the desired system.  

If the modem connection is open when you choose Login to another system the 
current connection will automatically be closed. 
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24 Using the system 
In this section the functions of SiPass Entro are described from the viewpoint of a 
person entering the building. How do you get in? How do you set an intrusion 
alarm?  

24.1 Entrance 
People entering the building can open a door in several different ways, depending 
on the security level: 

 By using their card at the card reader of a door terminal. 

 By using their card at a card reader. 

 By entering a group code at a card reader or a PIN reader. 

 By using their card and entering the PIN at a card reader. 

If the card/code is accepted, the green LED is lit and the lock is opened. 

If the person entering the door enters the wrong PIN three times in succession, the 
card will be blacklisted and must be re-validated at the PC. To indicate that a card 
is blacklisted for this reason, two asterisks (**) are displayed in front of the person’s 
name on the Persons tab in SiPass Entro. Double click the person’s name to 
withdraw the cancellation. 
 

 
The red LED (if it exists) on the reader can indicate in two ways that the alarm is 
activated.  

- Either permanently on all readers in the zone. 

- For a certain time and only on the reader where the command is performed. All 
other methods do not turn on the LED at all. 

24.2 Arm and disarm an intrusion alarm system 
To be able to arm and disarm an intrusion alarm system, the person must be a 
member of an access group with authorization to arm and disarm intrusion alarms.  

 Certain access groups can have authorization to arm an intrusion alarm only, 
while other access groups may only be allowed to disarm an intrusion alarm. 

 System users with all rights also can arm and disarm an intrusion alarm via the 
icons in the Door Monitor application. 

Arm an intrusion alarm system – with a card 
1. Press B on a door terminal. 

2. Use the card through the reader and enter your PIN (depends on the current 
security level).  

 The alarm is armed.  In
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The door is given the security level chosen in the Installer application (often Card + 
PIN security level), irrespective of the security level applying when the alarm was 
armed. This security level applies until the alarm is disarmed. 

Disarm an intrusion alarm system – with a card 
1. Use the card at the card reader of the door terminal.  

2. Enter your PIN (decided by the current security level). 

 When the alarm is disarmed the door is given the security level according to 
the defined time zones. 

24.2.1 Abort an automatic alarm arming cycle 

If the system is configured so that alarm arming is done automatically by a time 
schedule – people remaining in the facility are still able to abort an on-going alarm 
arming cycle. A warning signal sounds during this time. 

However - once the warning time ends there are no possibility to “buy time”. In-
stead the alarm is armed immediately. 

Proceed as follows: 

1. When you hear the warning signal (the alarm will soon be turned on), find the 
nearest door in the same zone. 

2. Use your card at a card reader. 
- or - 
Push the exit button (if allowed). 

 SiPass Entro will go back to the normal state – until the next automatic 
arming is started. 

3. You can remain in the facility until you hear the warning signal again – and 
repeat the steps above. 

24.3 Enter the duress code 
 

 
Duress works only during the Card + PIN security level. 

This is what the person entering the building should do if forced to open the door 
under threat. 

1. Use the card. 

2. Use the ordinary PIN and add up 1 number to the last digit in the PIN. 
Example 1: If the PIN is 1234, press 1235 instead. 
Example 2: If the PIN is 1239, press 1230 instead. 

 When a duress code is entered, the door is opened at the same time as the 
common alarm output in IOR6 can be activated (duress has to be defined as 
an alarm event for this to happen).  
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24.4 Set or change the PIN 
This is how a user sets or changes their PIN, if “Personal Setting” has been 
activated. 

1. Press the A button on the door terminal.  

 The yellow LED is lit. 

2. Use the access card through the card reader.  

 The yellow LED is lit. 

3. Enter the old PIN.  
- or - 
If you have no previous PIN, enter 0000.  

 The yellow LED blinks twice. 

4. Enter a new 4-digit PIN.  
The PIN 0000 cannot be used. 

 The yellow LED blinks twice. 

5. Enter the new PIN once again. 

24.5 Pop-up windows – and acknowledgement 
The system allows for choosing any event (in the filter settings for the actual 
system user) to be treated as an event alarm. This means that a pop-up window 
will appear on the screen whenever these alarms occur. (Note that these alarms 
not necessary mean an alarm related to an intrusion system). 

You have now the option to acknowledge the event – or not.  

If you need to review any older event – just uncheck the tick-box – and all alarm 
events are visible. 

24.5.1 Common alarm outputs 

There is a function called Common alarm (or summary alarm) that is related to the 
IOR6 relay controller outputs. 

Often these outputs are connected to external equipment to bring attention to a 
problem that needs action. 

The settings in the Installer application allows for two types of alarms: 

 Alarms that generates a pulse in the IOR6 Common relay and “pop-up” on 
screen and will then only be stored as an event. 

 Alarms that are set to activate the Common relay output as a toggle function 
and require an acknowledgement or another event to reset the relay.  

E g a door held open too long alarm will activate the relay and remain active until a 
door closed event reset the relay. 
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Only caretakers can reset any common alarm at a reader keypad. 

 

24.6 Caretaker functions 
Some doors can be configured to allow for a temporary change of security level. 
The door can be set Unlocked for certain times - or set to Group code (4 digits). 
The command is invoked at - and applies only to – a selected door. 

The prerequisite is that the person doing this must belong to an access group with 
the Caretaker tick box selected. 

24.6.1 Unlocked 

There are three different commands for a Caretaker to unlock the door. 

 A18 All caretakers can then reset/lock the door. 

 A19 Only the very same caretaker can then reset/lock the door. 

 A20 All authorized card holders can then reset/lock the door. 

Proceed as follows: 

1. Press A18, A19 or A20 and the yellow LED flashes three times.  

2. Use the card (+ PIN). 

 The yellow LED is lit. 

3. Enter the time when the door is to be locked again. E g 1600 for 4 PM. 

 The reader sets the door unlocked until the requested time (or a time zone 
change). 

24.6.2 Group code 

Proceed as follows: 

1. Press A21 and the yellow LED flashes three times. 

2. Use the card (+ PIN). The yellow LED is lit. 

3. Enter the time when the door is to be locked again. E g 1600 for 4 PM. 

4. Enter the group code with four digits (not 0000).  

 The yellow LED flashes once and the group code will work until the requested 
time (or a time zone change). Remote opening from PC will still work. 
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24.6.3 Reset door to normal state 

To reset to normal mode again before the requested time - proceed as follows: 

When unlocked 
Dependant if the command A18, A19 or A20 have been used when unlocking the 
door, different card holders can reset the door. 

 Use the card (+ PIN) in the same reader or use the Toggle reset from PC in the 
Door monitor program. 
 The door is locked and set to normal mode. 

When group code 
1. Press A21 and use the same card (+ PIN) in the same reader 

2. Press 0000. 

3. Press 0000 once again 

 The door is locked and set to normal mode. 

24.7 Quick search of card holders 
There are several ways to search card holders (persons) in the database. As long 
as the naming is consequent (e g first name first), it is easy the find the person you 
want. 

With initial character 
If the person window is active, a single letter will position the cursor to the first card 
holder starting with that letter. The search is done from left to right. All card holders 
will still be visible. 

With quick search field 
In the quick search field several characters can be entered (from left) and only the 
card holders that match are displayed. The filtering reduces the list dynamically 
when more search characters are entered. 

The filtering remains until you switch to another tab and go back – or end. 

With enrolment reader 
If an USB-RIF/2 reader interface (and a reader) is installed at the computer, a card 
can be presented for the reader. The system will directly display the card holders’ 
properties. 
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24.8 Advanced searching of registered persons 
Using this function you can search for all the persons granted access in the sys-
tem. 

1. Choose Person on the Search menu. The Search persons window is displayed. 

 In the Search persons window you can use a number of different search 
criteria in order to search for a person. For example, you can use the name, 
part of the name, the card number, the optional field or one of the access 
groups. You can also combine the search concepts and use “wildcards” and 
“jokers” (“*” and “?”). See the examples. 

2. Enter the desired search criteria. 

3. Choose whether the search should be case sensitive. If the check box is 
selected and the search criterion is “smith” the system will not find “Smith”. 

4. If the Match all criteria check box is selected, all entered search criteria must 
be matched for the person to be found. This alternative is best when the search 
consists of a combination of search criteria. If the check box is empty, only one 
of the criteria needs to be matched. 

5. Click Search. The name you searched for is displayed on a new, temporary tab 
called Search result. 

6. You may now, using the Search result tab, change the database information for 
this person. Just select the name and click Edit. To remove the person from the 
database, click Delete. 

If you are not satisfied with the search result, click the Change criteria button. The 
Search persons window is redisplayed. The original search criteria are saved for 
you to make the necessary changes. 

When you are finished you can remove the Search result tab by clicking the 
Remove tab button. 

24.8.1 Search example 

To find all persons belonging to a certain access group, simply select the desired 
access group. In addition it is also possible to select one or more doors in the lower 
frame. 

To find all persons by the name of Smith, enter the last name and an asterisk (*), 
i.e. Smith*. The asterisk (or wildcard) implies that any character and any number of 
characters may be found after the asterisk, the system will find them whatsoever. If 
you have registered the persons with the christian name first, enter the asterisk 
first, i.e. *Smith. 

To find all card numbers beginning with 1234, enter 1234 and an asterisk, i.e. 
1234*. 

Apart from asterisks, question marks (jokers) can be used in the search criteria, 
e.g. if you are not sure how the person spells his or her name. The question mark 
represents one character, any character. 
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24.8.2 Search with right-click on person – or door. 

You can mark one person in the list, right-click and select to show authorized 
doors. 

In the same way you can mark one door and all authorized persons will be shown. 
It possible to edit any selected person from this list. 

24.8.3 Import and export information about persons 

It is easy to import information about persons to SiPass Entro, from e.g. Excel. You 
may also export files to other applications from SiPass Entro. 

However extra cards, personal doors and/or pictures of cardholders are currently 
not supported by the import/export tool. 

24.8.4 Import information 

You can import most information about cards (persons). Please refer to the section 
about creating an Excel file [ 67] . 
 

 
If any person uses extra cards, personal doors or has a cardholder picture stored, 
you cannot import this information from a file. Instead you must enter this via the 
standard menus. 

1. Open the Entro [ 13] application. 

2. Choose on the menu File > Import persons. 

3. Find the file to import.  

4. Click Open. 

In
tel

lig
en

t S
ec

ur
ity

 &
 F

ire
 L

td



Using the system 

66 

Building Technologies 052_SiPass_Entro_6_5_A24205-A335-B318_e_en
Fire Safety & Security Products  10.03.2010

24.8.5 Export information 

You can also export most information about cards (persons) into a file. Note that 
the PIN is encrypted and cannot be understood. However - it can still be imported 
from the same file. 

1. Open the Entro [ 13] application. 

2. Choose on the File > Export persons menu.  

 The Export persons to file window is displayed. 

3. Find a folder where the file can be stored. 

4. Type a name for the file in the File name field.  

5. Click Save. 
 

 
The name of an access group must be identical. Both spelling and lower/upper 
case must be correct. If not – a complete new group will be imported without any 
authorities at all.  

If any person uses extra cards, personal doors or has a cardholder picture stored, 
you cannot export this information from a file. Instead you must enter this via the 
standard menus after you import the data again. 
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24.8.6 Create an import file in Excel 

1. Create one empty spreadsheet. E g Remove any Sheet 2, Sheet 3 etc. 

2. Be sure that actual cells are in Text format before you enter any information 
and store it in a file. (E g Excel can not manage leading zeroes in numerical 
fields.) 

3. The file should be of the format below for each person (row). 

4. Choose Save as on the File menu.  

5. In the File format list box, select the desired delimiter, e.g. semicolon. 

6. Type a name for the file in the File name field and click OK. 
 

Column Field Comments 

A Name (e g Surname)  

B Name (e g first name) 

Text 1) 

Note! Field A and B together maximum 32 
characters. 

C Free field Text (maximum 40 characters). 
E g E-mail address. 

D Card number Text value 3) (00000000-99999999) 
If Entro standard card parameters are used, 
padding zeroes will be imported to get eight digits. 

E PIN Text value 3) (0001-9999) 

F Valid Text 

Alt 1 YY-MM-DD 
Alt 2 YY-MM-DD - YY-MM-DD 

G Group 1 Text 2) (16 characters) – or empty 

H Group 2 Text 2) (16 characters) – or empty 

I Group 3 Text 2) (16 characters) – or empty 

J Group 4 Text 2) (16 characters) – or empty 

K Group 5 Text 2) (16 characters) – or empty 

L Group 6 Text 2) (16 characters) – or empty 

M Priority person Not imported – Leave empty 

N Counter Text value (00-99) 

O Member group no Text value (0-999999) 

P Card inactive Text Yes/No 

Q Free field 2 Text (maximum 40 characters). 

1) If name is imported from SiPass Entro Lite, the name truncated to the 32 first 
characters 

2) The name for a group must be identical regarding spelling and case. Otherwise 
a new group without any permission at all will be imported. For other software than 
Excel be sure that a delimiter character (e g semi-colon) is included for every 
access group not used. In
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3) If Personal code is used the Card number field must be empty and the Personal 
code in the PIN field.  

24.9 Backup of event files 
In cases where you want to archive events files (stored on the PC hard disk) on 
some other backup media, this can be copied separately. Remember to coordinate 
these operations with the automatic deletion of event files.  

Proceed as follows: 

1. Start Windows Explorer. 

2. Find the folder where the actual system user has specified to store the events. 

3. Select which user’s event files to archive. 

Dependant of the PC environment itself, there maybe many methods of doing this 
automatically. Consult the IT-manager. 

24.10 Backup of the database 
Normally it is sufficient to let the database (with all the settings, persons etc) be 
stored in every SR35i (and in the PC) to ensure the safety and integrity of the 
system. The more segment controllers there are – the more backup copies there 
are. 

However – it is possible to save a PC-file copy of the entire information on a 
backup media. Proceed as follows: 

1. Start Windows Explorer. 

2. Go to the Windows users profile folder. Example for Win XP: C:\documents and 
settings\Username\. 

3. Go to the database folder \Username\Application Data\SiPass Entro 
\Standard\. 

4. Copy all files to a suitable backup disk. 

Note the above method is only valid if no other database path is configured in the 
dbpath.ini 

There are also methods of doing this automatically, dependant of the PC 
environment. Consult the IT-manager. 

The installer can also use the menu system in the SR35i (SR34i) to store or re-
store the database to/from an existing CF8 memory flash card. However – this 
method shall be considered as an emergency operation and must be used with 
caution. 
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24.11 View system resources 
You can see how many doors, cards, time schedules there are that are used in the 
system.  

1. Open the Entro [ 13] application. 

2. Choose in the menu View. 

3. Select View system resources. 

 A graphic bar diagram displays the capacity of the system. 

4. Click OK. 

24.12 View and make reservations via Entro 
The System user of the SiPass Entro has the possibility to see all reservations 
made. Even new reservations for persons can be made via the PC used for 
administration. 

Remember that it is possible to make reservations in all objects that an End-user 
normally does not have access to. E g if an object is out of order, another similar 
object may be reserved instead.  

The System user may be asked to optionally send an e-mail confirmation to the 
user (if an e-mail address exist) and/or decide if the action shall be logged with a 
debit notation in the log (if there are debit values assigned to the object). 

24.12.1 View reservations in general 

Proceed as follows: 

1. Open the Entro [ 13] application. 

2. Select System > Manage Reservations. 

 A list is displayed with every reserved object and corresponding member 
group. 

3. Make new reservations by clicking the Make reservations icon. Doing this – 
there is also a choice for sending an e-mail confirmation message. 

 In a similar way you can cancel reservations by clicking Cancel 
reservations 

4. Exit the window. 

24.12.2 Make reservations for person 

It is possible to make reservations in the person list directly. Proceed as follows: 

1. Open the Entro [ 13] application. 

2. Mark a person in the list. 

3. Right-click and select Make reservations. 

4. Select in the list box Reservation object. 

5. Select date (by picking in calendar). In
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6. Choose one of the times written in black text.  

 Any green text is earlier reservations made for the member group. Any red 
times displayed are reservations made by another member group. 

7. Click on Make reservations. 

8. Exit window. 

Cancel reservations for person 
If want to cancel any reservation – follow as above and mark a green text but in-
stead click on Cancel Reservation icon. 

24.13 Make a reservation 

Prerequisite 
To be able to reserve times in the SiPass Entro Reservation system you need a 
standard web browser in a PC (MS Internet Explorer) - or a card reader together 
with a touch screen. The method depends on the type of installation. 

When you have made your reservation you may receive a confirmation by e-mail. 
You should already have been notified if this is method is in operation. If in doubt 
consult your System Administrator. 

When all settings are done, reservation can be done in two ways: 

 Login from a web browser in a computer – where the card number and the PIN 
are used as a password and identification.  

 Login at the booking terminal InfoPoint IP811 where the card number is used 
for identification. 

You then choose the relevant object and enter the times to reserve. 

24.13.1 Make a reserve with a web browser 

You need access to a standard PC with a browser (like MS Internet Explorer). In 
addition you need an IP-address (Internet) tied to a website (running in one of the 
SiPass Entro segment controllers). 

1. Start your browser and enter the IP-address to the website. 

2. You will see a login page for the reservation.  

3. Enter your card number and your personal code (PIN). The first time you will 
also have the choice of a suitable language. 

4. Select object and reserve times. 

5. Confirm your choices. (You can of course edit your choices). 

6. Log out. 

7. You can now wait for the reserved time and use your card in the reader at the 
reserved objects (e g the tennis court). 
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24.13.2 Make a reserve via a booking terminal 

In this case usually an InfoPoint IP811 is mounted local to the object. Together with 
this there is a card reader used for identification. 

1. You will see the Home page for the Reservation system 

2. Use your card at the card reader. The first time you will also have the choice of 
a suitable language. 

3. Select (by using arrows) the objects and times you want to reserve. 

4. Confirm your choices. (You can of course edit your choices). 

5. Log out. 
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